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UNDERSTANDING THE JPEG FORMAT
I am not sure about you, but I think that if I were to see the Queen down at the local supermarket,
well, I’m not sure what I would do. Ask her if she prefers the whiter and brighter washing powder
or is she a liquid user? Or how about running into that pouty female Oscar winning actress at the
local servo? We ordinary folk may aspire to the wealth and fame of those figure heads but the
reality is that we must endure a far more mundane existence.

I

n like manner, I do tend to bang on about saving all images in
the original RAW format. There a myriad of reasons why you
should do that. But in reality, most of you don’t. Your camera
can provide the ‘rich and famous’ RAW format, rich in
information and detail, famous for the amount of information
stored in those shadows and highlights, but we tend to set it to the
more mundane JPEG, the shoe shine and garbo collecting format.
Lets look at why most casual photography buffs and weekend
warriors leave their camera on ‘save jpeg only’ in the camera’s
menu.
First, that’s how the camera came out of the box. If your manual
has a ‘quick start’ section, that’s about as far as we tend to look
when first using a new camera. And changing saved formats is
never in there. It will be buried deep into the manual, where your
brain would have long ago given up trolling through all the
complicated jargon associated with custom set-ups.
Second, for some reason, finding out that you can fit 5000 jpeg
images on your camera’s memory card, as opposed to only 100300 RAW images, seems to be a much better deal. It’s as if we
think it’s going to cost money to store the bigger file. Maybe this is
a throwback from film days where more exposures meant more
cost but with digital, hey! you can cheat the money monkey and
squeeze in far more shots on your card if you use JPEG format. Or
it may also be a throwback from the days when a 1gb hard drive
was very expensive so you wanted files to be as small as
possible. Or you may be a survivor of the Y2K fiasco, caused by
programmers skimping on the date format to save space on their
10mb hard drives.
Third, most camera users have end requirements for their
photographs that rarely require the ‘rich and famous’ RAW format.
There’s not much to inspire you to pull out extra detail in those
blocky shadows or blown highlights if all you are going to do is
squint at the image on your camera’s LCD screen once you are
back on board your dive boat. Or no point in getting that colour
balance just perfect if you are just going to upload the pic onto
your Facebook page. For starters, web browsers don’t have colour
management capability so any minor colour tweaking along with
saving embedded colour profiles is going to be ignored and/or
reinterpreted by the browser in some random fashion that will
make all your work for naught.

JPEG format and ignore the George Clooney RAW format, let’s
look at what the JPEG format does that is positive, negative, useful
and annoying. At least that way you will have a better grasp on
what best suits your photographic requirements.
JPEG or JPG is just one of many formats in which you can save a
photo file. My old Photoshop 7 has 20 different formats in which I
can save an 8 bit image file, a few of which are JPEG variations.
JPEG is preferred for web use, including email, as the resulting
conversion to JPEG format can impressively reduce the size of the
file on your hard drive or any other storage device including
backup DVD’s. When your photo editing software opens a JPEG
file it is transformed into exactly the same image size as it was
before it was compressed. So, a saved file that is only, say,
800kb can, when opened, have an uncompressed file size of 2030 or more megabytes. A file sized to A4, or full page in this
magazine, at 300dpi (dots per inch or pixels per inch) will
normally be 25mb in size. If you were to save it as a JPEG then it
may be compressed down to a file that is only 100kb, a tiny
fraction of the original size. Save it as a TIFF file without

compression and the same file stored on your hard drive will show
up at the full 25mb.
As much as we may wish it otherwise, there is no free lunch.
There is a price for such extreme compression. A JPEG file
employs what is known as ‘lossy compression’. That means that
when you save an image you will lose information. Taken to
extremes, a JPEG file can look like your dog’s breakfast, as
information is dumped by the compression process to reduce the
file size of the image.
Down at the pixel level of your image, saving in JPEG format will
give your photo a jagged and/or blocky appearance. This is
particularly evident in areas where there is a sharp contrast
change, such as a white strip on a black wetsuit. The transition
area takes on a typical jagged appearance. What the process is
doing is taking a certain number of pixels and changing their
values. While not technically accurate, you can think of it as
picking a blue pixel and making all the others around it the same
colour and/or density value. So, if a single pixel is bordered by 8
pixels, instead of having 9 lines of code to describe each of the
pixels, the whole section can now be described with one line of
code. As I said, this is not technically correct as the process is
much more complex than that, but in principle this is how the
system works.
Now if you are just sending emails or posting images on a web
page, this compression is not really an issue. In fact, if you were
to post an uncompressed TIFF file next to a JPEG on a web page,
you would not see any real difference. The same may be said of
small colour prints, particularly if the original exposure was spot
on and no major fiddling is required. However, let’s look at some
extremes to see what you can do to avoid the pitfalls of using
JPEG as your working file format.
For starters, all JPEG files are not created equal. Open any image
in your photo editing software. Make sure it is in 8 bit mode as
16 bit images cannot be saved as JPEG files. In Photoshop that
would be under Image>Mode>8 bits/channel. Now save the file
using ‘Save As...’ under the File menu. Give the file a new name
then under the Format drop down menu, choose ‘JPEG’ (if it is not
already chosen). If JPEG is not available it is always due to the
above mentioned 8 bit vs 16 bit problem. Also, depending on
your software, it may not be available if you have layers in your
image.

Zooming in on a lionfish photo saved as a level 10 JPEG, the
image (A) is a typical JPEG file with not a lot of information in
the highlights and a bit of the jaggies appearing on the edges
of the fins. But, considering the zoom level, it is not too bad.
However, exactly the same image saved at level 0-2 shows
up a lot of the problems that lossy compression causes with
the smooth background breaking up into squares of pixels
and edge sharpness degenerating.

So, assuming that many of you readers will stick to the Joe Bloggs
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You can also embed the colour profile of your choice at this stage,
using the check box at the bottom, but, as mentioned above, if
you are only using it on a web page the profile will be ignored by
the browser.
You are now presented with the JPEG Options window, the most
important part being the Quality setting. Drag the slider across to
10 or 12. Depending on your software version the maximum
quality (meaning minimum compression) can vary with older

A RAW file, in the process of being converted, does not have
jagged JPEG compression artefacts, blocky pixel clumps or
edge blurring (A). At this stage, a choice of colour profile, bit
level (16 bits has been chosen) and resolution and dpi (B). A
White Balance can also be specified (C) but I prefer to shoot
on Auto White Balance and use Photoshop to tweak any
colour shift.

versions only going to 10. At the bottom of the window is an
indication of the size of the saved file as well as how long, at a
given speed, the file will take to be transmitted. The higher the
quality, the larger the file, the less compression and the greater the
time taken to transfer. For reproduction, I suggest 10 or more. For
colour prints: 5-10, for web page and email (i.e. for viewing only,
not printing or reproduction) you can use 2-5. I’ve even used 0
and the image looks just fine in an email. Obviously, these lower
numbers represent the more extreme compression levels.
So, if the image looks OK in a highly compressed form, what’s the
big deal? The problems start when the image is re-saved. Not
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digital photography
copied, as in
burning to a
disc or making
a duplicate. If
you open a
JPEG file, do
nothing to it
and then close
it then no
changes occur.
But if you open
a JPEG then resave it (usually
after doing
something to
the file), going
through the
saving process
above, the
After selecting JPEG as my format of choice in the
previously
‘Save As...’ dialogue box, along with selecting the
compressed file
check box to save it with the colour profile, my
has another
JPEG Options dialogue box that now pops up
compression
allows me to choose a level of compression. You
algorithm
can enter a number or select a level from the drop
applied. So if
down menu (A). The size of the saved file will be
you have a
displayed (B), the value being the size of the
compressed file at the level of compression you
photo of a
choose. For web use I use a much lower level
diver, saved as
giving a much higher compression, say level 4 or
a JPEG by the
3. If I select the Baseline Optimized option (C) I will
camera, then
save a little more file size without changing the
you open it in
compression. The third option is rarely used as it is
your photo
often annoying to have images reveal through a
editing
series of scans. This was used more often back
software to
when high speed meant a 56k modem.
make some
changes and
re-save it, the image will lose more information. Then, let’s say you
open the changed file and create a new file for a wall print and
save it, then open that file and make a smaller file for a party
invite, you soon find that the image looks like a badly pixellated TV
screen. Each time you saved the image, the compressed file had
additional compression which removed more texture, detail and
colour information. Each time you re-save a JPEG file you do more
damage.
Another factor that comes into play is the amount of adjustments
you make to an image. A photo that is correctly exposed with good
colour balance will put up with a lot more abuse than a badly
underexposed photo with electronic noise in the shadow areas.
Since JPEG files are in 8 bit mode, they have already dumped a
whole lot of information that could have been used during the
correction process. This is particularly evident when you view the
Levels window (Image>Adjustments>Levels...). A 16 bit file will
have a smooth histogram while an 8 bit JPEG file with a lot of
exposure and/or colour adjustments will show a gappy, jagged
histogram where complete areas of colour and density are missing.
In extreme cases this will show up as a form of mild posterisation or

lack of smoothness in transition areas between subtle colours. For
example, a blue water background will begin to show banding or
abrupt colour changes. Add some heavy compression when saving
the file and you are going to end up with a rather sad result.
To add insult to injury, the default colour space for most cameras
will be sRGB. This is a colour profile intended for web or internet
use or for simple programs such as Powerpoint. A colour profile is
a description of the colours used in an image. If the profile does
not describe certain colours then they do not show up. A good
example of this is the CMYK colour space used for printing this
magazine. There are many CMYK colour profiles but they all have
fewer colours available than the RGB profiles that you use. That is
why, when compared to the original, magazine printed images are
a lot less saturated, particularly the blues and cyans found in
underwater images.
The sRGB profile has fewer colours available than wider profiles
such as Adobe RGB (1998) or ProPhoto RGB. Again, with a
perfectly exposed image this is normally not a major issue, but
once you begin to add up all the factors (8 bit only, underexposed,
lossy compression, re-compression artefacts, narrow colour profile,
etc) you can see how your photos can quickly become less flexible
or, at worse, useless. You can change the colour profile your
camera applies to your JPEG files. Just check your manual to find
out which menu item will do that for you. I would recommend the
Adobe RGB (1998) profile.
Another factor to take into consideration is that you have to choose
a colour balance. Your camera will probably come with a range of
colour balances to be applied to all photos you take. Indoor
lighting, flash or
strobe lighting,
fluorescent lighting,
etc. To keep things
simple I recommend
you just set it to Auto.
This will work in most
situations. The last
thing you need is to
be fiddling around
with colour balance
when the two mating
manta rays, with your
buddy firmly attached,
goes by. If you are
shooting macro with
only strobe light in
your shots, then you
might choose the Flash
or Strobe setting, but
After a few saves, our lionfish looks a
generally the Auto will
little jagged and blocky (A) with the
work just fine.
open water background starting to
To summarise, the
benefits of shooting in
RAW are: 16 bit
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show banding and fine detail blurring
or merging. Our file saved from RAW
as a TIFF then saved as a JPEG (B)
looks much better.

instead of 8 bit for
more colour and
density information,
particularly for
pulling out shadow
detail and/or
clawing back
texture in bright
areas. No need for
a colour profile or
white balance, that
is all done in the
process of
converting from the
RAW file into a
photograph. No
compression so no
After imitating a bad exposure by
loss of detail and
making the lionfish darker, then
texture. Once
lightening it again, this 8 bit file is
converted, a RAW
starting to strain under the load. The
file can be saved as
Levels dialogue box (Image >
a high quality TIFF
Adjustments > Levels) shows the
file in 16 bits with
histogram turning into the ‘comb tooth’
structure of an image which is missing
all colour and
pixels in most of the luminance range,
density adjustments,
particularly in the shadow to mid range
easily converted to
area. An underexposed JPEG would
an 8 bit JPEG for
most probably be much worse than this,
web or other uses.
especially if it is saved with additional
Your ‘rock star’
compression.
RAW file can
always be
downgraded when necessary, like one hit wonders of the pop
genre who now work in a car wash or restaurant kitchen.
Negatives: you have to convert each file from RAW to an image
file so there is a lot more work. This can be overcome to some
degree with batch processing or by having your camera save both
the RAW file and a JPEG copy. You can then use the RAW file to
work on more difficult images while using the JPEG files for correct
exposures.
Positives for JPEG are small size per image file and a wider range
of uses (i.e. many print outlets demand JPEG format, web sites
need JPEG for speed of loading, etc). Negatives: the lesser
amount of colour and texture information in an 8 bit image file,
compression of image will remove texture and colour information
(and once it is gone, it is gone for ever), a colour profile and
colour balance must be chosen prior to shooting, your Joe Bloggs
format cannot be upgraded to ‘rock star’ status, it just does not
have the wealth of information needed.
So while I always save the RAW format, I do understand why
some prefer the default JPEG system. But for the sake of a few
dollars and a larger memory card, why not save the RAW file as
well? You never know when you may need a visit from Elvis.
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